HD Connect
Desktop App for HD Flame Detector
Publication 372001-22 Rev. B
INTRODUCTION
This manual contains information for HD Connect the Desktop App for the Forney HD Flame Detector from Forney Corporation, 16479 North Dallas Parkway, Suite 600 Addison, TX 75001.

All personnel should become thoroughly familiar with the contents of this manual prior to using this product. Because it is virtually impossible to cover every situation that might occur during operation and maintenance of the equipment described in this publication, personnel are expected to use good engineering judgment when confronted with situations that are not specifically mentioned herein.

PROPRIETARY NOTICE
The contents of this publication are proprietary data of Forney Corporation. Reproduction or use of any part of the publication for purposes other than the support of the equipment for which it is published is permissible only if expressly authorized in writing by Forney.

SAFETY AWARENESS
Safety is YOUR responsibility and must always be primary concern. The guidelines covered in this manual will greatly improve your ability to safely install and maintain this equipment. It is the equipment owner’s responsibility to ensure that the concerned personnel fully understand and abide by all site-specific Health, Safety, and Quality protocols. Safety summaries and procedures can never replace good common sense!

PERSONAL PROTECTIVE EQUIPMENT (PPE)
All involved personnel should follow their site-specific Health, Safety, and Quality guidelines.

SAFETY ALERT SYMBOLS
ALL labels in this manual should be carefully observed, read, and understood. Standard labels are as follows:

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER</td>
<td>Indicates a hazardous situation which, if not avoided, will result in death or serious injury.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Indicates a hazardous situation which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Indicates unsafe practices that can result in property damage only.</td>
</tr>
</tbody>
</table>

Revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>07/17/2018</td>
<td>Initial Release</td>
</tr>
<tr>
<td>B</td>
<td>02/15/2019</td>
<td>Update Monitor and Tune Screen shots, add note on page 4</td>
</tr>
</tbody>
</table>

NOTICE
If any of the procedures or instructions provided in this manual are unclear, contact Forney for clarification. Forney Corporation offers complete, on-site service solutions to ensure proper installation, programming, commissioning, and troubleshooting.
Table of Contents

Section 1 HD Connect Overview .................................................................................................................. 4
  1.1 Login Screen ........................................................................................................................................... 4
  1.2 User Security Configurations .............................................................................................................. 5
  1.3 Welcome Screen ................................................................................................................................... 6

Section 2 Menu Options ................................................................................................................................... 7
  2.1 File Menu ............................................................................................................................................. 7
  2.2 View Menu ........................................................................................................................................... 8
    2.2.1 Spectrum ........................................................................................................................................... 8
    2.2.2 Log View ......................................................................................................................................... 9
    2.2.3 Saved Tuning .................................................................................................................................. 9
    2.2.4 Views ............................................................................................................................................... 10
  2.3 Settings Menu ...................................................................................................................................... 11
  2.4 Help Menu .......................................................................................................................................... 11

Section 3 Icons Bar ......................................................................................................................................... 12
  3.1 Logout Icon .......................................................................................................................................... 12
  3.2 Fault Log Icon ..................................................................................................................................... 12
  3.3 Log View Icon ..................................................................................................................................... 13
  3.4 Spectrum View Icon ............................................................................................................................ 13
  3.5 Refresh Icon ....................................................................................................................................... 13

Section 4 HD Icon Menu .................................................................................................................................. 14
  4.1 Monitor Window .................................................................................................................................. 15
  4.3 Monitor or Tune Window ..................................................................................................................... 16
  4.4 Tune Window ...................................................................................................................................... 17
    4.4.1 Flame Relay Settings ....................................................................................................................... 18
    4.4.2 Device Settings ............................................................................................................................... 18
    4.4.3 Save Tuning .................................................................................................................................... 18
    4.4.4 Factory Reset .................................................................................................................................. 19
    4.4.5 Reset Forgotten Password ............................................................................................................ 19
  4.5 Spectrum ............................................................................................................................................. 20
  4.6 Tags ....................................................................................................................................................... 21
  4.7 Live Trends ......................................................................................................................................... 22
  4.9 Data Logging ....................................................................................................................................... 23
  4.10 Fault Status ...................................................................................................................................... 24

Section 5 Appendix ........................................................................................................................................ 26
  5.1 Contact Information .............................................................................................................................. 26
  5.2 Common Acronyms ............................................................................................................................... 26

List of Figures

Figure 1 Login Screen .................................................................................................................................. 4
Figure 3 Security Configuration Pop-up ....................................................................................................... 5
Figure 3 Standard User Security Options ..................................................................................................... 5
Figure 4 Welcome Screen ............................................................................................................................ 6
Figure 5 File Menu ..................................................................................................................................... 7
Figure 6 View Menu ................................................................................................................................... 8
Figure 7 Pop-up Window for Spectrum ......................................................................................................... 8
Figure 8 Pop-up Window for Log View Sub-menu ....................................................................................... 9
Figure 9 Results of Log View Filter ................................................................. 9
Figure 10 Settings Menu – Language Selection ............................................. 11
Figure 11 Help Menu Options ...................................................................... 11
Figure 12 HD Connect Icon Bar ................................................................. 12
Figure 13 Fault List in HD Connect ............................................................. 12
Figure 14 Right-Click Menu Option for HD Icons ....................................... 14
Figure 15 Monitor Window in HD Connect .................................................. 15
Figure 16 Tune Password Window in HD Connect ...................................... 17
Figure 17 Tune Window in HD Connect ....................................................... 17
Figure 18 Tune Window Device Settings Tab ............................................... 18
Figure 19 Spectrum Window for UV sensor ............................................... 20
Figure 20 Spectrum Window for IR sensor .................................................. 20
Figure 21 “Tag List” Window in HD Connect ............................................. 21
Figure 22 Live Trends and Options ............................................................ 22
Figure 23 Configure Data Logging Tab of Data Logging Screen .............. 23
Figure 24 Log History Tab of Data Logging Screen ................................. 23
Figure 25 Fault Status Window .................................................................. 24

List of Tables

Table 1 Permissions for Standard Users ...................................................... 5
Table 2 Description of Menu Options ....................................................... 7
Table 3 Common Fields Defined ............................................................... 16
Table 4 Fault Codes .................................................................................. 25
Section 1 HD Connect Overview

HD Connect software is a user-friendly tool used to monitor performance and tune the HD Flame Detector using a Windows® computer. The software connects to the HD Flame Detector via RS-485 connection (Communication port).

HD Connect can be installed on a Windows® computer running Windows 8 or later. Please follow installation instructions provided separately to install the software.

Note:
1. HD Connect and HD App cannot be simultaneously connected to the same HD-01 Flame Detector. At any given time, an HD Detector can communicate with only one external device (either through HD Connect or the HD App).
2. When using HD Connect, if an HD Flame Detector does not appear in the list of connected devices, check and verify if the target device is already connected to a mobile device using Forney App over the Bluetooth® connection. If the target HD Detector is connected via Bluetooth, first disconnect Bluetooth connection, then hit refresh button in HD Connect to discover the target device.
3. A maximum of 32 HD-01 Flame Detectors can be attached on a single USB/COM port using the RS-485 connector. If more than 32 HD-01 Flame Detectors need to be connected to the same computer, the user must either use a USB hub or attach them on separate USB ports on the computer.
4. If HD Connect or any DCS controller is continuously pulling data from an HD Detector, it must be disconnected (by unchecking the corresponding box in HD Connect Software -- see Section 1.3) on COM port of HD Connect or other prescribed procedure for DCS controller prior to connecting it via Bluetooth. Furthermore, the Forney App should be launched on the mobile device after disconnecting the HD from COM port.

1.1 Login Screen

HD Connect launches with a Login screen as shown in the Figure 1. HD Connect has two possible user types: admin and standard. The admin users can add, delete and modify permissions for new or existing users, while standard users have restricted access.

![Figure 1 Login Screen](image)

Several features in HD Connect allow users to save data in log files, change register values, view live data or change HD parameters. The permission to perform these functions are set by admin users for standard users.
1.2 User Security Configurations

Admin users have permission to perform any function in *HD Connect*. Figure 1 and Table 1 below list the functions controlled by Admin users for standard users. The Admin simply clicks the features they would like the standard user to have access to.

---

**Figure 2 Security Configuration Pop-up**

**Figure 3 Standard User Security Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spectrum*</td>
<td>Allows users to view the Spectrum screen.</td>
<td>2.2.1</td>
</tr>
<tr>
<td>Saved Tuning</td>
<td>Allows users to view previously Saved Tunings.</td>
<td>2.2.3</td>
</tr>
<tr>
<td>Log View*</td>
<td>Allows users to save and view log files.</td>
<td>2.2.2</td>
</tr>
<tr>
<td>Localization</td>
<td>Allows users to change the language for the <em>HD Connect</em>. Options are: English, Spanish, and Chinese.</td>
<td>2.3</td>
</tr>
<tr>
<td>Fault Log</td>
<td>Allows users to create and view Fault Logs.</td>
<td>3.2</td>
</tr>
<tr>
<td>Monitor*</td>
<td>Allows users to view the status of HD Detectors.</td>
<td>4.1</td>
</tr>
<tr>
<td>Tune</td>
<td>Allows users to make changes to the tuning of the HD Flame Detector.</td>
<td>4.4</td>
</tr>
<tr>
<td>Tags</td>
<td>Allows users to troubleshoot HD Detectors. Good understanding of Tags is required, so Admin should be careful in allowing user’s permission for this feature.</td>
<td>4.6</td>
</tr>
<tr>
<td>Live Trend*</td>
<td>Allows users to view Live Trends, which are useful to learn HD current and future trends.</td>
<td>4.7</td>
</tr>
</tbody>
</table>
### Data logging
- Allows users to log data from Monitor page.  
- Section 4.9

### Fault Status
- Allows users to view and reset Faults.  
- Section 3.2

*Forney recommends enabling these features for all standard users.

#### 1.3 Welcome Screen

Once a user logs onto *HD Connect* it launches a welcome screen as shown in the Figure 4. The left side of the screen (referred as equipment tree) has the list of COM ports and devices attached to each COM port. The check-box in the equipment tree can be used to connect/disconnect any COM port or equipment.

The top of the screen has 4 menu items and 5 icons. The menu items are described in Section 2 while the icons are described in Section 3.

The large window on the right side of the equipment tree displays the icons of currently connected HD Flame Detectors.
- A green box around the icon represents a fully operational HD Flame Detector with no issues.
- An orange box around the icon represents a fault on the HD Flame Detector.
- A red box around the icon means there is **no** communication between the HD Detector and the computer.

A pop-up menu opens upon right-mouse click on any icon. Details of the pop-up menu are described in Section 4.

![Figure 4 Welcome Screen](image-url)
Section 2 Menu Options

The 4 menu items in the top area of HD Connect are:

- File
- View
- Settings
- Help

2.1 File Menu

The File Menu has 6 sub-menu items:

**Figure 5 File Menu**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save View</td>
<td>Saves the current view in a file at desired location on the computer. The HD Flame Detector icons can be rearranged in any desired manner as explained in Section 2.2.4. The Save view option allows users to arrange icons in different ways and save their view.</td>
</tr>
<tr>
<td>Open View</td>
<td>Allows user to upload previously saved view. Essentially, it rearranges the icons on screen in user’s preferred way that was previously saved by the same user.</td>
</tr>
<tr>
<td>Refresh</td>
<td>If HD units are added/removed in the daisy chain, their status can be updated by pressing Refresh. This menu option updates the list of current HD Detectors connected by RS-485; it also updates the status of all the detectors currently connected via USB port.</td>
</tr>
<tr>
<td>Logout</td>
<td>Logs out the current user from the software and returns to the Login Screen.</td>
</tr>
<tr>
<td>Security Configuration</td>
<td>Opens a pop-up window, see Section 1.2. Admin users can create/delete admin or standard users or change permissions for standard users. Standard users can view their permissions in this pop-up window.</td>
</tr>
<tr>
<td>Exit</td>
<td>Logs out the current user and exits HD Connect application.</td>
</tr>
</tbody>
</table>
2.2 View Menu
The View Menu has 4 sub-menu items.

2.2.1 Spectrum
The pop-up window for “Spectrum” sub-menu has two drop-downs:
1. Port Address: displays the list of COM ports with active devices.
2. Device Address: shows list of connected HD Flame Detectors for the selected COM port.

After selecting desired COM port and Flame Detector, click “Display” to see the IR/UV spectrum. The Spectrum window is explained in detail in Section 4.5.
2.2.2 Log View

The pop-up window for “Log View” has two drop-downs on the left side:

- Select Port: lists COM ports with active devices.
- Select Slave: lists connected HD Flame Detectors for the selected COM port.

![Figure 8 Pop-up Window for Log View Sub-menu](image)

The middle section allows the user to filter specific “From” and “To” dates and time. Clicking the “Show” button on the right side displays the filtered results. If date and time are left blank, then the results window will show all results.

As shown in Figure 9, the results page displays the list of registers changed, their old and new values, change date, and user who changed the value.

Admin users can add privileges for standard users and decide if a user can view the historical changes in the register values as explained in Table 1. Whenever any parameter for a HD Flame Detector is changed (using Tune window), the value in corresponding register changes. The changes in the registers are logged and can be viewed later. This information can be useful for Forney Professionals to troubleshoot issues with HD Flame detector.

![Figure 9 Results of Log View Filter](image)

2.2.3 Saved Tuning

The “Saved Tuning” option allows users to upload the same settings on multiple HD Flame Detectors. The user can load a previously saved tuning, Section 4.4.3 explains how to save a tuning. The software will redirect and populate the Tune Page to show these retrieved parameters from the encrypted file on the computer. These settings can then be uploaded to the connected HD Flame Detector by clicking “Update Detector” button.

NOTICE

Previously saved tunings do not include Device Settings. These settings should be manually changed, if needed, prior to clicking “Update Detector”. If an application requires use of more than one profile, each profile must be activated through profile select inputs prior to updating detector.
2.2.4 Views

The “View” option under the “View” menu has three options:

**Standard View** lists all the connected flame detectors sorted by COM port.

This view **cannot** be customized.

**Custom View** allows users to move HD icons in any desired pattern.

To rearrange the icons, simply drag the icons to the desired location on the screen. The user can then save their view using the “Save View” option on the File Menu.

**Run-Time View** shows the current Flame Status and corresponding Flame Strength for each detector. The user can also arrange these icons as described under **Custom View**.

**Note:** Run-Time view requires continuous data transfer between Computer and HD; which can slowdown RS-485 communication or the computer.
2.3 Settings Menu

Settings menu, shown in Figure 10, offers the user three (3) languages:

- English,
- Chinese, and
- Spanish.

Once the desired language is selected, the application logs out to convert the software to the selected language. The user then needs to log back in to view HD Connect in the desired language.

![Figure 10 Settings Menu – Language Selection](image)

2.4 Help Menu

The Help menu has two (2) resources available for users:

1) Instruction Manual and
2) Terms and Conditions.

Clicking either of these options opens the respective document in pdf format.

![Figure 11 Help Menu Options](image)
Section 3 Icons Bar

Figure 12 shows the HD Connect icon bar which consists of 5 icons:

- Logout,
- Fault Log,
- Log View,
- Spectrum, and
- Exit.

3.1 Logout Icon
Logs out the current user and redirects to the login page. Admin users can create new user and set their permissions as needed.

3.2 Fault Log Icon
A pop-up window opens when the Fault Log icon is pressed. The pop-up window (left picture in Figure 13) allows user to select ‘From’ and ‘To’ date and time to display the faults occurred within the time-frame. The fault list results (right picture in Figure 13) shows all the faults occurred in all the HD Flame Detectors connected within the time-frame selected on the prior window.

![Figure 12 HD Connect Icon Bar](image1)

![Figure 13 Fault List in HD Connect](image2)
3.3 **Log View Icon**
Opens the Log View Pop-up Window. See Section 2.2.2 Log View.

3.4 **Spectrum View Icon**
Opens the Spectrum screen. See Section 4.5 Spectrum

3.5 **Refresh Icon**
When pressed, the Refresh icon refreshes the list and status of HD Flame Detectors in the Equipment Tree and Icons area (Please see Section 1.3 for the description of the two windows).
Section 4 HD Icon Menu

The large area on the right side of the *HD Connect* screen displays an icon for each HD Flame Detector currently (or previously) connected via RS-485. The icons can be displayed in three different views as described in Section 2.2.4.

Right mouse click on any of the HD icons to make a pop-up menu open as shown below. These menu options are explained in detail in the following sub-sections. Please note that one (1) window can be opened for each HD Detector. HD Connect does not allow multiple windows for a single HD Detector.

*Figure 14 Right-Click Menu Option for HD Icons*
4.1 Monitor Window

The Monitor Window displays the status of the desired HD Detector. The user can view the status of the Flame Relay 1 or 2 for the active profile from 0 to 3. The Monitor screen shows the current values of several parameters and various set-points for the selected flame relay and profile combination.

Figure 15 Monitor Window in HD Connect
4.3 Monitor or Tune Window

Monitor and Tune screens have several common fields. These fields are explained in this section with the help of data processing flow.

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Displays sensor type for respective Flame Relay (FR1/FR2) UV or IR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Signal</td>
<td>Displays sensor signal strength on a scale of 0-1023 after processing though pre-amplifier. Displayed value is influenced by amount of optical radiation received by the sensor and the preamp gain set by the user. It is recommended that in no case this signal value should reach 1000. The sensor signal strength in range 200-600 will help improve flame discrimination.</td>
</tr>
<tr>
<td>Preamp Gain</td>
<td>User adjustable preamp gain (1-255) to achieve sensor signal as described above.</td>
</tr>
<tr>
<td>Gain</td>
<td>User adjustable Gain (1-255). Sensor Signal at the output of pre-amplifier stage is processed through second amplifier. Output of amplifier is processed by microprocessor and results of FFT are presented in Spectrum screen. X scale of the spectrum displays 256 bins at interval of 2 Hz, while signal amplitude at each bin is displayed on Y axis. Its recommended that in no case signal strength on any bin should reach 1000. Optimize Gain / Preamp Gain settings to keep signal amplitude at burner characteristic frequency bin around 600.</td>
</tr>
</tbody>
</table>

| Frequency Window 1, Amplitude 1 | Highest amplitude between two frequency bins (starting & ending) is displayed as Amplitude 1 |
| Frequency Window 2, Amplitude 2 | Highest amplitude between two frequency bins (starting & ending) is displayed as Amplitude 2 |
| Weight | User adjustable between 1-5. Highest amplitude on each frequency window is multiplied by the weight setting and displayed as Amplitude 1 and 2. Default value is 1. Increasing preamp gain or gain increases signal and noise together. It may lead to low signal to noise ratio. However higher weight setting only acts as a multiplier of Amplitude. |
| Amplitude PU/DO | Flame Relay status is controlled by comparing highest of two Amplitude (1&2) values against PU / DO set point. Flame Relay energizes if either amplitude is greater than PU setting and de-energizes if both amplitude values are below DO setting |
| Analog Signal % | Displays analog output signal value in %. Analog signal is scaled as per the Min & Max settings on tune page. |
| Gain Trim Control | When on, automatically adjusts Preamp gain to maintain sensor signal to fixed value of 600. In dark furnace condition, adjusts Preamp gain to 25 to avoid saturation. |
| Flame Failure Response Time (FFRT) | Flame Relay energizes if either amplitude is greater than PU setting and de-energizes if both amplitude values are below DO setting after expiry of FFRT setting. Default setting is 1 second; possible values are 2, 3, and 3.8 seconds. |

IR Spectrum with Frequency Windows 1 and 2 shown in blue and orange colors respectively, and DO/PU shown in green color.
4.4 Tune Window

The Tune Window option allows the user to Tune the selected HD Flame Detector.

When the Tune option is clicked, a pop-up window opens requiring the user to enter a password as shown below. The Default Factory Password is 1234. Password can be changed under the Device Settings section.

![Figure 16 Tune Password Window in HD Connect](image1)

**Figure 16 Tune Password Window in HD Connect**

![Figure 17 Tune Window in HD Connect](image2)

**Figure 17 Tune Window in HD Connect**

The “Extend Timer” button at the top right corner of the window can be used to extend the duration of tune mode in *HD Connect* without the need to provide HD Flame Detector’s Password (4-digit password).
4.4.1 Flame Relay Settings
Select Flame Relay Settings for FR1 or FR2 by clicking on the desired tab in the Tune Window Figure 17. The current settings are shown in green on the left, to change the set points for Frequency, Amplitude, Weight Factor, Pre-Amp Gain, Gain, Analog scale (%) and Gain Trim Control enter new values into the gray boxes on the right. See Table 3 for definitions of variables.

Click “Update Detector” or “Save Locally” to save your changes. See Save Tuning section for more details.

4.4.2 Device Settings

![Figure 18 Tune Window Device Settings Tab](image)

Click on the Device Settings tab to change Modbus Slave ID, Tag Name, FFRT value for each Flame Relay and Tune Password. Simply type in new values on the right and click to “Update Detector” or “Save Locally”. See next section for explanation of Save options.

4.4.3 Save Tuning
Two options exist to save settings in Tune Mode, “Update Detector” or “Save Locally”. The “Update Detector” sends the desired settings from HD Connect to the HD Flame Detector and saves them on the Detector. A confirmation is issued from the detector to the HD Connect. HD Connect displays success or failure in a subsequent pop-up window. Alternatively, the existing settings can be saved at a desired location on the computer using the “Save Locally” button in Tune window. Please note that the values on the left column(s) of ONLY FR1 and FR2 are saved while the values under Device Settings section are NOT saved. Only settings for active profile are saved. Forney recommends user
include profile number in saved file name for easy identification later. If an application requires use of more than one profile, each profile must be activated through profile select inputs prior to saving settings.

Previously saved tunings can be uploaded from the computer by clicking Saved Tuning in the Menu bar. This feature allows the user to upload the same settings on multiple HD Flame Detector devices.

### 4.4.4 Factory Reset

The factory default button on Tune page restores the settings to factory default values. Please note Factory Reset will reset Modbus Slave ID to XXX where XXX are last 3 digits of the serial number and Tune mode password to 1234. Factory reset does not change user assigned Tag number.

### 4.4.5 Reset Forgotten Password

To reset a forgotten password, please contact Forney Service Department to request the unit specific password. Please provide last five digits of the unit serial number and its six-character Tag name when requesting reset password. Forney will generate a device specific password which can then be used to enter tune mode and reset the standard password to a desired password. A new device Specific Master Password may be required if locked out again.
4.5 Spectrum

The Spectrum Analysis (FFT) provides insight into the signal from each sensor (UV or IR). It helps identify frequency windows and respective amplitude specific to the target flame and used as a guide to change parameters on the Tune screen (Figure 17). Signal amplitude values are at frequency bin intervals of 2 Hz. For example, amplitude at 60 Hz frequency is displayed at frequency bin 30 on the spectrum screen.

To view the Spectrum Windows simply:

- Click on Spectrum from the pop-up menu.
- Use the check boxes in the top right corner to select IR or UV.
- Use the drop-down menu to select the best scale interval 250, 500, 750, and 1100 for viewing the spectrum.

![Figure 19 Spectrum Window for UV sensor](image)

![Figure 20 Spectrum Window for IR sensor](image)
4.6 Tags
Click on the Tags to review the information about all available tags and their relevance for the Flame Detector. The Tags window show the register numbers, their descriptions, and associated values for various registers of HD Flame Detector. In case of normal communication with HD Flame Detectors, these values are displayed in different windows of HD Connect. For example, Slave ID (Register # 40000) is displayed on Monitor, Tune, Spectrum windows. In case of communication issues between HD Flame Detector and HD Connect, the values associated with Tags can be useful to troubleshoot issues by a Forney Professional.

Figure 21“Tag List” Window in HD Connect
4.7 Live Trends

Live data for Flame Relay 1, Flame Relay 2, and Internal Temperature can be viewed for any connected HD Flame Detector. Hover the mouse over the Live Trends option to view its sub-menu. When any of the options (FR1, FR2, or Internal Temperature) is clicked, the Live Trend window opens and starts plotting the live data from the Flame Detector (right-top screen in Figure 22).

**Save Live Trends**: To save a trend, click “Save Trend” button and save file to a desired location on the computer (right-bottom screen in Figure 22).

**View Previously Recorded Trends**: Click on the “Recorded Trends” tab and select “Load Trend” button to locate and open a previously saved Live Trend (left-bottom screenshot in Figure 22).

*Figure 22 Live Trends and Options*
4.9 Data Logging
Data logging can be initiated by setting COM port, Modbus Slave ID and From/To time for any specific HD Flame Detector. Any or all registers can be chosen to record current or future data. The data will then be stored at the user specified location and can then be imported into Excel® for further analysis. The Configure Data Logging tab shows the various options to start data logging. The Log History tab shows previously saved data files.

NOTICE Data logging is not password protected; so data saved by one user can be viewed by another user provided they exchange data files.

Figure 23 Configure Data Logging Tab of Data Logging Screen

Figure 24 Log History Tab of Data Logging Screen
4.10 Fault Status

Clicking on Fault Status opens the Fault Status window as shown in Figure 25. If the red fault LED on the HD Detector is lit, click on the Fault Status window to determine the cause for the fault. The fault type and fault counters for each sensor are shown here. Power cycling the detector resets the fault alarm on the detector (red LED is no longer lit), however it does not clear alarms displayed on this screen.

If any HD is in fault state with red LED on the front display lit, user should:
1. Reset fault by cycling power to the HD Detector, this will clear the detector out of fault state (red LED on front display will turn off),
2. Then use the Fault Status page in HD Connect to determine the reason for the fault.
3. Use ‘Clear Alarms’ button to clear alarm displayed on this screen. Alarm counters will continue to display current value.

**NOTICE**

The Alarms must be cleared after a fault occurs to accurately determine fault next time.

![Figure 25 Fault Status Window](image-url)
### Table 4 Fault Codes

<table>
<thead>
<tr>
<th>Value</th>
<th>Error Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No Error</td>
</tr>
<tr>
<td>1</td>
<td>Unknown HW (Hardware) Fault</td>
</tr>
<tr>
<td>2</td>
<td>Unknown SW (Software) Fault</td>
</tr>
<tr>
<td>3</td>
<td>HW Fault - EEPROM</td>
</tr>
<tr>
<td>4</td>
<td>SW Fault - Factory Values Reset</td>
</tr>
<tr>
<td>10</td>
<td>Temp Fault</td>
</tr>
<tr>
<td>11</td>
<td>Temp Alarm</td>
</tr>
<tr>
<td>12</td>
<td>Temp Above</td>
</tr>
<tr>
<td>20</td>
<td>Modbus Error</td>
</tr>
<tr>
<td>24</td>
<td>Illegal Slave ID</td>
</tr>
<tr>
<td>30</td>
<td>Bluetooth Error</td>
</tr>
<tr>
<td>33</td>
<td>Illegal Data Value / Value Not Accepted Outside of Tune Mode</td>
</tr>
<tr>
<td>35</td>
<td>Bluetooth pairing failed</td>
</tr>
<tr>
<td>36</td>
<td>Bluetooth Connection Error</td>
</tr>
<tr>
<td>37</td>
<td>Bluetooth Authentication Error</td>
</tr>
<tr>
<td>40</td>
<td>FR1 Sensor Fault</td>
</tr>
<tr>
<td>50</td>
<td>FR2 Sensor Fault</td>
</tr>
<tr>
<td>60</td>
<td>Watchdog Fault</td>
</tr>
<tr>
<td>70</td>
<td>FR1-New Discrepancy Fault</td>
</tr>
<tr>
<td>80</td>
<td>FR2-New Discrepancy Fault</td>
</tr>
</tbody>
</table>
Section 5 Appendix

5.1 Contact Information
For assistance, contact Forney’s Aftermarket Department via any one of the following methods.

<table>
<thead>
<tr>
<th>E-mail</th>
<th>Phone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:spares@forneycorp.com">spares@forneycorp.com</a></td>
<td>972-458-6100 or 972-458-6142 or 1-800-356-7740 (24-hour direct line)</td>
<td>972-458-6600</td>
</tr>
</tbody>
</table>

5.2 Common Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FFT</td>
<td>Fast Fourier Transform</td>
</tr>
<tr>
<td>FR</td>
<td>Flame Relay</td>
</tr>
<tr>
<td>HW</td>
<td>Hardware</td>
</tr>
<tr>
<td>IR</td>
<td>Infrared signals</td>
</tr>
<tr>
<td>SW</td>
<td>Software</td>
</tr>
<tr>
<td>UV</td>
<td>Ultraviolet Signals</td>
</tr>
</tbody>
</table>